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Einleitung
Wir wollen einen menschenähnlichen Character erstellen, der trotzdem einige besondere Merkmale besitzt. 
Dieser Character erhält eine große Nase und große Stiefel.
Das Tutorial ist auf die Bedienung von 3DStudioMAX R3 (engl.Version) abgestimmt und beschreibt das 
Boxmodeling, Meshsmooth und die Texturierung mittels UVW-Mapping bzw Unwrap-UVW sowie einige 
weitere Modelingverfahren wie Loft und Boolean. Wir benötigen keinerlei zusätzliche Plugins.
Ich habe versucht das Tutorial reichhaltig zu bebildern und die Schritte ausführlich zu beschreiben. Deshalb 
denke ich, dass auch Einsteiger hiermit ihr Vergnügen haben werden, jedoch benötigt man trotzdem einiges 
an Zeit und Geduld um gute Ergebnisse zu erzielen ;o)
Zwischenspeichern nicht vergessen!!

Dann fangen wir auch gleich mal an.

Chapter1 - Kopf-Grundform

 : Undo/Redo-Buttons; die Anzahl der Undo-Schritte wird im 
Menüpunkt Customize -> Preferences festgelegt

 : CreateRollout; hier stehen die Grundobjekte bereit

 : ModifyRollout; hier sind alle Modifier zu finden

 : am ModifierStack; ua Objektkonvertierung

 : am Modifier-Stack; löscht den Modifier auf der momentan aktiven 
Ebene

Das Gesicht besteht im Prinzip aus Augen, Nase, Stirn+Mund. Den Rest 
nennen wir einmal das Grundobjekt. Deshalb erstellen wir das 
Grundobjekt aus einer 7x7x3erBox, wobei wir frontal auf die 7x7er-
Fläche schauen. Aus dieser Box werden alle wichtigen Teile 
herausgearbeitet.
Als nächstes wenden wir den Relax-Modifier [Modify -> More -> Relax] 
an. Den RelaxValue stellen wir auf 1 und für die Iteration ist 13 ein recht 
guter Wert. Wir sehen nun, wie sich die Form abrundet.
Danach können wir die Form mittels FFD[Modify -> More -> FFD2x2x2] 
genauer an die Kopfform anpassen. Im Rollout rechts den SubObjekt-
Button drücken und die ControlPoints des FFD-Netzes anwählen und wie 
gewünscht das Objekt verformen.
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-> Oft ist es hilfreich sich eine kleine ModelingArena zu erschaffen. Dazu 
erstellt man zwei senkrecht aufeinander stehende rechteckige Surfaces, 
die dann mit den jeweiligen Bildern einer Front und einer Seitenansicht 
eines Kopfes gemappt werden. Anhand dieser Bilder kann man die Form 
des Kopfes, der Nase etc besser anpassen. Wir verwenden hier jedoch 
keine ModelingArena, weshalb ich auch nicht näher darauf eingehe ;o)
Wenn wir mit der Grundform soweit zufrieden sind konvertieren wir das 
Objekt in ein EditableMesh. Dabei müssen wir den ModifierStack 
collapsen [CollapseAll -> Warnung ignorieren -> Ok]
Dies ist unser Grundkörper, der gegenüber einer Kugel gewisse Vorteile 
besitzt.

Chapter2 - Die Nase

 : ExtrusionsController im EditableMesh-
Rollout

 : Selektion abgewandter SubObjekte 
an/abschalten

 : Selektiermodus

 : Move-Button; ermöglicht verschieben von (Sub)Objekten

 : gleichmäßiger Skaliermodus

 : versteckt die selektierten SubObjekte 
bzw zeigt sie wieder an

 : ArcRotate; neben Pan und Zoom das wichtigste Werkzeug für das 
Perspektivfenster

 : Rollout, in dem Einstellungen zum Verstecken, Einfrieren etc der 
Objekte vorgenommen werden können

 : Zusammenführen zB der selektierten Punkte

Nun können wir mit dem Modeling der Nase beginnen. Wie in der 
Einleitung bereits erwähnt soll die Nase unseres Characters etwas größer 
als gewöhnlich sein :o)
Zunächst schalten wir IgnoreBackface an, damit wir in der FrontView 
keine SubObjekte am Hinterkopf mitauswählen. Über den SubObject-
Schalter wechseln wir in den SubObject-Modus, wählen dort Polygon aus 
und markieren bei gedrückter Strg-Taste die links abgebildeten Polygone. 
Über den Extrusions-Controller extruieren wir die gewählten Polygone 
einmal "nach außen" und schieben sie dann auf die richtige Höhe. Für die 
Nasenspitze und die Nasenflügel extruieren wir nochmals je das dafür 
passende Polygon.
Nun wechseln wir in den Punktmodus[SubObject -> Vertex] und sind 
sogleich mit einem Wust an Punkten konfrontiert. Natürlich können wir 
uns auch hier das Leben leichter machen, indem wir alle nicht benötigten 
Punkte markieren und dann im Rollout den Hide-Button drücken. Die 
Punkte sind dann versteckt und können auch nicht selektiert werden, bis 



der UnhideAll-Button sie wieder freigibt. Beim Markieren an die 
IgnoreBackfacing-Box denken ;o)
Jetzt können wir mit dem Verschieben der Punkte beginnen, so dass die 
Nase noch mehr Form annimmt. Eine sehr gute Methode ist es die Punkte 
im Left-Fenster zu markieren, wobei IgnoreBackfacing nicht markiert ist, 
und sie dort zu verschieben bzw mittels des Skalierers anzunähern oder 
voneinander zu entfernen. So arbeitet man schön parallel auf beiden 
Seiten. Nach gelungener Anpassung wagen wir uns an die Nasenlöcher. 
Wir wählen am Besten in der Perspektivansicht die unteren Polygone der 
Nase aus und wenden auf sie den MeshSmooth-Modifier[Modify -> More 
-> MeshSmooth] an. Die Checkbox "Apply to whole Mesh" müssen wir 
deaktivieren. Wenn wir nun im Rollout den MeshSmooth-Type auf 
Classic setzen bekommen wir eine wunderbare Unterteilung der Fläche, 
so dass sich die beiden Polygone rechts und links wunderbar zur 
Extrusion anbieten. Zunächst müssen wir jedoch wieder den 
ModifierStack collapsen um ein EditableMesh zu erhalten. Dann 
selektieren wir die beiden Polygone und extruieren sie 2mal "nach innen".
Ein genaueres Bearbeiten machen wir dann anhand eines 
Referenzobjektes, auf das wir den MeshSmooth-Modifier anwenden. Wir 
gehen aus dem SubObjekt-Modus heraus und klicken bei gedrückter Shift-
Taste auf das Objekt. In dem Optionsfenster wählen wir Reference und 
benennen es sinnvollerweise auch so. Dann verschieben wir das 
Referenzobjekt etwas zur Seite und weisen ihm den MeshSmooth-
Modifier[Modify -> More -> MeshSmooth] zu. Wir belassen es bei der 
Grundeinstellung. Eventuell können wir, um eine bessere Abrundung zu 
erreichen Iteration auf 2 stellen. Der große Vorteil ist es nun, dass wir 
unserem Low-Poly arbeiten können und die Auswirkungen in Echtzeit an 
unserem Referenzobjekt sehen können :o) Dadurch können wir die 
Punkte gleich richtig zurechtschieben. Links sind LowPoly und dessen 
Referenzobjekt abgebildet.

Die Stirnpartie erhalten wir indem wir im Punktmodus folgende Punkte 
"vereinigen" dh collapsen. Wir wählen immer die zwei Punkte aus und 
drücken dann den Collapse-Button unten im Rollout.

Nach dem Finetuning sollten wir dann aufgrund der Performance das 
Referenzobjekt über das Hide-Rollout verstecken[Display -> Hide 
selected].

 



 

Chapter3 - Die Augenpartie

 : Mirror spiegelt Objekte und SubObjekte

 : im Mesh-Rollout; erstellt aus den selektierten 
SubObjekten ein neues Objekt

 : im Mesh-Rollout; macht aus mehreren Objekten ein 
Mesh, ohne deren Aufbau zu verändern

 : im Mesh-Rollout; zeigt an, wieviele SubObjekte 
momentan ausgewählt sind

Dann nehmen wir uns als nächstes die Augen vor. Wir werden zunächst 
nur ein Auge modelieren und es dann spiegeln und auf der anderen Seite 
einarbeiten.
Zunächst markieren wir die wie im linken Bild gezeigten Polygone, 
extruieren und verkleinern sie. Dann löschen wir sie über die Entf-Taste. 
Im Punktmodus formen wir dann anhand der inneren Punktreihe in der 
FrontView eine Augenform. Nun müssen wir die Punkte noch in der Tiefe 
richtig verschieben. Dazu erstellen wir eine Kugel, der uns als Augapfel 
dient. Größe und Lage der Kugel sind in etwa vom Nasenrücken bis zur 
Schläfe und die seitliche Lage der Mittelachse ist in etwa auf der Höhe der 
Schläfe. Oben links ist die Lage in den beiden Ansichten klein abgebildet. 
Nun verschieben wir die Punkte am Besten im Perspektivfenster, wobei 
wir diese exakt entlang einer Achse verschieben können, indem wir mit 
dem Cursor auf die jeweilige Achse des Punktes gehen, in die wir ihn 
verschieben wollen. Die Achse wird dann etwas heller und wenn wir den 
Punkt dann verschieben folgt er der Achse. Ausserdem sollten wir den 
Smooth+Highlight-Modus aktivieren, indem wir mit einem Rechtsklick auf 
die Bezeichnung 'Perspektive' ein Popupmenü öffnen, in dem wir dann den 
Anzeigetyp wählen. Ist dies getan verschieben wir nun also die Punkte 
soweit, bis sie gerade noch sichtbar sind und nicht von der Kugel 
geschluckt werden. Eventuell müssen auch andere Punkte verschoben 
werden, dann müssen wir jedoch daran denken dies wieder parallel auf 
beiden Seiten zu tun.
Das obere Augenlied extruieren wir im SubObjekt-Modus 'Edge'. Wir 
wählen die oberen Edges des Augenringes aus und extruieren diese nach 
außen. Dann wechseln wir in den Punktmodus und collapsen die links im 
Bild eingefärbten gelben Punkte. Um scharfe Kanten am Auge zu 
vermeiden extruieren wir den ganzen inneren Augenring noch in die Kugel 
rein und vergrößern ihn ein bisschen wie links abgebildet.
Anhand des Referenzobjektes können wir unser Auge wieder überprüfen 
und Verbesserungen vornehmen. Es kann sehr gut sein, dass wir aufgrund 
der Abrundung des MeshSmooth einige gewünschte Details nicht 
erkennen. In dem Fall müssen wir einige Punkte extrem verschieben, so 
dass unser LowPoly etwas verzerrt aussieht, jedoch kommt es im Endeffekt 
ja auf das Aussehen des Referenzobjektes an. Eine solche Extremstelle ist 
zum Beispiel der Wangenknochen :o)
Wenn wir mit unserem Auge zufrieden sind ist es an der Zeit es auch auf 
die andere Gesichtshälfte zu übertragen. Wir verstecken zunächste das 
Referenzobjekt und dann alle Punkte, die nichts mit den Augen zu tun 



haben. Diejenigen, die wir brauchen sind links abgebildet. Die roten sind 
die des Auges und die blauen die der Stelle, wo das Auge hin soll. Es ist 
wichtig darauf zu achten nicht zu viele Punkte zu verstecken. Dann 
markieren wir die Punkte des Auges und drücken im Rollout den Detach-
Button. Wir wählen Detach as Clone, damit wir ein neues Objekt erhalten. 
Danach spiegeln wir das neue Objekt über den Mirror-Button und das 
Objekt sitzt auch schon an der richtigen Stelle. Bevor wir nun das Auge 
einfügen müssen wir noch die zwei Polygone an dieser Stelle löschen um 
keine Überschneidungen zu bekommen. Als nächstes wählen wir den Kopf 
aus, drücken im Rollout den Attach-Button und klicken dann auf das 
Augenobjekt. Jetzt ist es in das Mesh aufgenommen. Nun müssen wir nur 
noch alle links markierten gelben Punkte der Reihe nach mit denen des 
Kopfmeshes collapsen und schon ist das Auge eingearbeitet. Um zu 
schauen, ob man wirklich die zwei richtigen Punkte gewählt hat, kann man 
im Rollout schauen, wieviele Vertices man gewählt hat und ein Blick auf 
die Lage des Achsenkreuzes zeigt einem, ob die Punkte auf einem Fleck 
liegen, was sie bei uns ja sollten :o)
Ein kurzer Test anhand eines neuen Referenzobjektes ist auch hier 
sinnvoll, um später bösen Überraschungen vorzubeugen. Ausserdem könne 
wir nun schon die Schläfen durch das zueinanderskalieren der beiden in der 
SideView selektierten Punkte herausarbeiten und die Wangenknochen 
hervorheben.

Nun sieht unser Kopf doch schon recht ansehlich aus und das alles ohne 
wirklich großen Arbeitsaufwand und in verhältnismäßig flotter Zeit ;o) Ich 
hoffe Du bist soweit bisher auch gut mit- bzw zurechtgekommen und mit 
dem Zwischenergebnis zufrieden. Wenn ja dann können wir uns ja der 
Mundpartie widmen :o)

 



 

Chapter4 - Die Mundpartie

 : MeshRollout; Group extruiert alle 
gewählten SubObjekte in eine Richtung, Local extruiert jedes SubObjekt 
entlang seiner Normalen

Die Mundpartie ist etwas schwieriger, da wir teilweise auf sehr engem 
Raum Punkte ohne Überschneidungen anordnen müssen. Aber mit etwas 
Konzentration und den ArcRotate-Werkzeugen des Perspektivfensters 
werden wir das schon meistern ;o)
Wir verstecken das Referenzobjekt, um flüssiger arbeiten zu können und 
formen aus den uns zur Verfügung stehenden acht Punkten zunächst in der 
Frontview über verschieben und skalieren einen Mund(siehe links). Hier ist 
es später besonders wertvoll, wenn wir alle Punkte bis auf diese acht 
zunächst verstecken. Auch hier unbedingt an das parallele Arbeiten 
denken, bei dem wir immer beide Punkte markieren und in der Seitansicht 
verschieben bzw über das Skalierwerkzeug sich annähern bzw voneinander 
entfernen lassen. Dann wählen wir die drei Mundpolygone aus und 
extruieren sie drei mal nach außen, wobei wir die erste Extrusion größer 
skalieren und die nachfolgenden immer einen kleinen Tick runterskalieren. 
Jede Extrusion hat 8 Punkte, wobei diejenigen rechts und links die 
Mundwinkel darstellen. Das bedeutet, dass wir nun diese Punkte von allen 
Extrusionschritten so nahe wie möglich zusammenbringen, ohne sie jedoch 
überschneiden oder aufeinanderliegen zu lassen. Mit den anderen Punkten 
formen wir dann die Unter- und die Oberlippe. Die erste Extrusion ist 
demnach die äußere Linie, die zweite Extrusion die innere Mundlinie und 
die dritte Extrusion liegt sozusagen vor den Zähnen. Haben wir die Punkte 
soweit richtig verschoben, wählen wir nochmals die drei Polygone, die 
jetzt schon im Mundraum liegen und extruieren sie noch einmal kräftig 
nach innen um einen Mundraum zu schaffen. Man kann alternativ auch 
eine Extrusion nach der anderen machen und zunächst die Punkte 
anordnen. Um die Punkte richtig anzuordnen ist die Perspektivansicht 
abwechselnd im Smooth und Wireframe-Modus sehr hilfreich.
Schließlich erstellen wir noch das Grübchen über der Oberlippe mittels 
Extrusion, wobei wir die oberen Punkte rechts bzw links collapsen. Und 
dann betrachten bzw verbessern wir alles wieder einmal mittels unseres 
Referenzobjektes. Nachdem wir wieder alle Punkte über den UnhideAll-
Button sichtbar gemacht haben können wir auch gleich noch das Kinn und 
die Wangen in Form bringen, was mit dem Verschieben bzw Skalieren 
weniger Punkte schon erledigt ist.
Das Ergebnis sieht dann in etwa so aus.



Nachdem wir diese Hürde genommen haben bringen wir unseren Kopf 
mittels Punktmanipulation und bei größeren Bereichen noch zusätzlich 
mittels SoftSelection, das wir im MeshRollout finden etwas mehr in Form, 
dh den Schädel und den Hinterkopf etwas ausarbeiten, die Wangen und das 
Kinn nachformen und weitere Dinge, die uns noch nicht gefallen 
ausbessern.

So könnte unser Kopf dann momentan als LowPoly und ReferenzObjekt 
mit MeshSmooth aussehen. Nicht übel oder? ;o)

Im nächsten Kapitel werden wir uns dann den Ohren zuwenden.

 



 

Chapter5 - Die Ohren
Die Ohren dürfen natürlich nicht fehlen. Jedoch ist das menschliche Ohr 
äußerst kompliziert aufgebaut, weshalb wir es hier nur sehr vereinfacht 
modelieren.
Zunächst wählen wir die zwei Polygone aus, an denen das Ohr am Kopf 
sitzen soll. Über das Menü Edit -> SelectInvert und das Drücken des Hide-
Buttons im DisplayRollout verstecken wir alle bis auf diese beiden 
Polygone. Wir wählen diese aus und extruieren sie einmal wie links 
abgebildet. Dann schieben wir die Punkte so zurecht, dass wir vorne einen 
weichen Übergang und hinten eine Einbuchtung erhalten. Dies ist 
sozusagen die Extrusionsebene hinter dem Ohr. Die nächste Extrusion gibt 
die äußere Form des Ohres an und die Punkte müssen wir 
dementsprechend weit nach außen verschieben. Die nächsten beiden 
Extrusionen formen das Innere der Ohrmuschel und werden 
dementsprechend weiter nach innen verschoben. Bei dem rechten der 
mittleren Bilder habe ich die Extrusionsebenen eingefärbt. Die 
Ursprungsebene ist hellgelb, die erste Extrusion ist rot, die zweite blau, die 
dritte dunkelgelb und die vierte hellrot. Unten rechts können wir anhand 
der weißen Extrusionslinie die Extrusionen verfolgen. Schließlich haben 
wir innen im Ohr zwei Polygone, von denen wir das untere auswählen und 
es nach innen extruieren, wodurch wir den Gehörgang erhalten. Anhand 
des Referenzobjektes formen wir das Ohr nun richtig aus wobei eine 
realistische Ohrvorlage oder das Fühlen am eigenen Ohr ;o) hilfreich ist.
Sind wir mit der Form zufrieden lassen wir uns wieder alle Polygone 
anzeigen und werden merken, dass das Ohr vermutlich etwas arg absteht. 
Das bedeutet wir müssen das Ohr noch richtig in Größe und Lage des Ohrs 
sowie den weichen Übergang vorne an den Kopf anpassen. Dies erreichen 
wir auch recht schnell über Punktverschiebung und evtl noch mittels 
SoftSelection.
Das Ohrs sollte seitlich in etwa in der Mitte des Kopfes sitzen und von der 
Höhe ungefähr von den Augenbrauen bis zur Verlängerung des 
Mundwinkels reichen.
Wenn wir uns mit dem Ohr angefreundet haben übertragen wir es genauso 
wie das Auge auf die andere Seite. Das bedeutet die beiden Polygone auf 
der anderen Seite zu löschen, die Ohrpolygone als Clone zu detachen und 
zu spiegeln. Das Ohr sitzt dann schon an der richtigen Stelle. Das geklonte 
Ohr ordnen wir dann über den Attach-Button wieder dem Kopf-Mesh zu 
und collapsen die entsprechenden Vertices.
Und schon sind wir fast fertig. Zuvor überprüfen wir jedoch nochmals die 
Proportionen und schauen, ob im Referenzobjekt alle gewollten Details zur 
Geltung kommen. Nach einigen kleinen Verbesserungen sind wir mit dem 
Kopf zufrieden :o)

Dann können wir ja mit dem Hals weitermachen.

 



 

Chapter6 - Hals, Körper und Beine
Dieses Chapter ist relativ kurz, da sich durch die Extrusionen im Prinzip 
alles selbst erklärt. Trotzdem kann ich mir einige Worte nicht verkneifen 
;o)
Wir wollen zunächst den Hals modelieren. Dafür wählen wir die Polygone 
auf der Unterseite des Kopfes aus. Es sind vermutlich 16 Polygone, die wie 
im Bild links angezeigt, angeordnet sein sollten. Nach der Extrusion 
verschieben wir wieder die unteren Punkte parallel auf beiden Seiten so, 
dass wir eine schöne kräftige Form für den Hals bekommen. Besonders 
den Nackenbereich sollten wir etwas kräftiger machen. Außerdem 
extruieren wir aus dem vorderen Polygon den Adamsapfel, wobei wir das 
extruierte Polygon etwas runterskalieren.

Die nächste Extrusionsebene geht dann stark in die Breite, da sie die 
Schultern schon einbezieht und das Schlüsselbein formt. Bis zum Gesäß 
folgen noch etwa sechs Extrusionen, bei denen die Körperform 
herausgearbeitet wird. Allzu viel muss man dabei jedoch nicht tun ;o) Man 
sollte die Wirbelsäule, die Brust und die Taille über Skalierung und 
Verschiebung herausarbeiten. Außerdem bietet sich ein Polygon 
wunderbar zur Extrusion des Bauchnabels an. Das Gesäß wird über zwei 
weitere Extrusionen geformt.

Unterhalb des Gesäßes nehmen wir nur noch die rechte bzw die linke 
Hälfte der Polygone, wobei wir die mittleren beiden Polygone aussparen, 
so dass wir den Ansatz des rechten und linken Oberschenkels 
herausextruieren können. Nach einer weiteren Extrusion versuchen wir auf 
der Innenseite einige Punkte zu collapsen, so dass wir in dieser Ebene nur 
noch fünf Vertices haben. Ich habe das im Bild links unten gelb bzw blau 
eingefärbt. Wir erstellen noch drei Extrusionen für das Knie und eine 
unterhalb des Knies. hier hören wir auf, da unser Character ja Stiefel 
bekommen soll, die wir seperat erstellen. Ansonsten würden wir weiter bis 
zu den Füßen extruieren und dann die Zehen jeweils als einzelne Extrusion 
erstellen. Dieser Vorgang wird uns jedoch in ähnlicher Weise bei den 
Händen noch begegnen. Damit MeshSmooth die unteren zur Extrusion 
markierten Polygone in die Abrundung nicht miteinbezieht löschen wir 
diese.
Eine genaue Bearbeitung über das Referenzobjekt lassen wir hier einmal 
sein, da unser Character sowieso noch angezogen wird ;o)

 



 

Chapter7 - Die Stiefel
So...zunächst weg vom menschlichen Körper und hin zu den übergroßen 
Stiefeln :o) Diese sollen kurz unterhalb des Knies anfangen.

Im Prinzip sind sie sehr schnell gemacht. Aus einer einfachen Box, das wir 
in ein EditableMesh konvertieren, wird das untere Polygon zunächst 
viermal nach unten extruiert, wobei die rechten Punkte der beiden letzten 
Extrusionen nach rechts verschoben werden. Dann extruieren wir das 
rechte Polygon nach rechts und ziehen den oberen rechten Punkt etwas 
nach oben. Die Sohle entsteht indem wir die unteren beiden Polygone 
zweimal extruieren. Das sieht dann in etwa wie links oben abgebildet aus. 
Als nächstes extruieren wir wieder zweimal das obere Polygon, wobei wir 
die Extrusionen skalieren und die erste nach unten verschieben, so dass ein 
Überhang entsteht. Dann müssen wir wieder einmal Punkte skalieren und 
verschieben, so dass das erstellte Referenzobjekt in etwa wie oben 
abgebildet ausschaut. Den zweiten Stiefel erhalten wir durch spiegeln.
Vor dem Spiegeln sollten wir den Stiefel noch anhand der Figur auf die 
richtige Größe skalieren. 

Chapter8 - Die Hose

 : MeshRollout; im Create-Modus kann man das jeweilig 
angewählte SubObjekt erstellen

 : MeshRollout; flipt bzw dreht zB abgewendete Polygone 
um

Jetzt steht er schon in den Schuhen...geben wir ihm als nächstes eine Hose. 
Diese soll kurz über den Knien aufhören und etwas pumpiger sein.

Das bedeutet wir müssen die Polygone unterhalb der Gürtellinie bis zu den 
Knien bearbeiten. Natürlich ist es zeitlich sinnvoll gleich die Hose zu 
modellieren statt zunächst der Beine etc.
Wir selektieren die für die Hose benötigten Polygone und erzeugen über 
Detach (as Clone) ein neues Objekt. Dann beginnen wir am Saum indem 
wir die untere Polygonreihe markieren, extruieren, größerskalieren und die 
unteren Punkte nach unten verschieben wie es im Bild oben links 
abgebildet ist. Genau dasselbe machen wir in etwa am anderen Hosenbein. 
Den Rest der Hose pumpen wir über Punktverschibung und Skalierung auf. 
Nur die oberste und unterste Punktreihe sollte nicht verändert werden.
Für den Gürtel verwenden wir die obere Polygonreihe, die wir einmal nach 
außen extruieren, wobei wir darauf achten müssen, dass wir als 
Normalenrichtung Local auswählen. Für die Gürtelschnalle können wir 
einfach nur die inneren Punkte collapsen und dann die beiden Polygone 
nach außen extruieren. Oder wir überbrücken den Zwischenraum, indem 



wir ein Polygon einfügen. Dafür drücken wir im Polygonmodus im 
MeshRollout den Create-Button und wählen dann gegen den Uhrzeigersinn 
die vier Punkte aus, zwischen denen das Polygon aufgespannt werden soll. 
Das Polygon wird mit einem Doppelklick gesetzt und erscheint dann 
sofort. Sieht man es jedoch nicht so ist es verkehrtherum ausgerichtet. Ein 
Klick auf den Flip-Button dreht den Normalenvektor und dadurch das 
Polygon um.
Wir erstellen wieder mal ein Referenzobjekt(Shift+Mausklick, Reference 
wählen, MeshSmooth-Modifier zuweisen) und prüfen und verbessern 
unsere Arbeit. Damit die Hose nicht zu glatt ist wählen wir im 
MeshSmooth-Rollout statt Nurms Classic und stellen den RelaxValue auf -
1.
Fertig ist die Hose. Die nun von der Hose verdeckten Körper-Polygone 
können wir löschen.

Die LowPolys mit ihren ReferenzObjekten sehen nun ungefähr so wir links 
abgebildet aus. Machen wir nun als nächstes die Arme.

 



 

Chapter9 - Die Arme
Für die Armextrusion markieren wir die fünf wie links oben abgebildeten 
Polygone. Nach der ersten Extrusion collapsen wir die auf dieser Ebene 
liegenden blau markierten Punkte. Dadurch erhalten wir eine bessere Form 
der Axelhöhle und reduzieren gleichzeitig die Punkte. Bei der nächsten 
Extrusion collapsen wir dann die grünen und gelben Punkte. Den Ellbogen 
setzen wir über zwei Extrusionen wobei wir wieder zwei Punkte collapsen. 
Nun sind wir bei den gewünschten 5 Vertices pro Ebene. Zwei weitere 
Extrusionen bilden dann den Unterarm und das Handgelenk. Nun formen 
wir anhand der wenigen Punkte einen Bizeps und heben vor allem die 
Schultern etwas an. Wieder daran denken bei bestimmten Punkten parallel 
auf beiden Seiten zu arbeiten.
Nach einem kurzen Überprüfen der Proportionen beginnen wir dann als 
nächstes mit dem Modeling der Hand. 

Chapter10 - Die Hand

 : Rotationsmodus, (Sub)Objekte können gedreht werden

 : Auswahl verschiedener Achsen zB für Rotationen

Die Hand modelieren wir zunächst als Einzelobjekt und verbinden sie dann 
wenn wir fertig sind mit dem Arm.

Die Finger
Zunächst benötigen wir wie links abgebildet eine 4x3x1er Box als 
Grundobjekt. Diese konvertieren wir in ein EditableMesh und und 
extruieren aus den vorderen vier Polygonen jeden Finger einzeln. Jeder 
Finger besteht dabei aus sechs Extrusionen, wobei an jedem Gelenk zwei 
Extrusionsebenen vorhanden sind. Es ist vorteilhaft, nachdem man einen 
Finger extruiert hat diesen etwas runterzuskalieren, damit man nachher 
leichter die zugehörigen Punkte auswählen kann. Den Daumen extruieren 
wir zunächst wie links im Bild angezeigt. Die Länge der Finger und die 
Abstände zwischen den Gelenken können wir schon festlegen. Eine gute 
Vorlage hat man ja mit der eigenen Hand ;o)

Bevor wir jedoch weitermachen wenden wir uns zunächst den 
Fingernägeln zu. 



Die Fingernägel
Die Fingernägel sind nicht so einfach hinzubekommen. Deshalb versuche 
ich jeden Schritt genau zu erklären und zu bebildern.
Als erstes ist es sinnvoll alle Punkte bis auf die des an dem zu arbeiteten 
Fingers zu verstecken. Nun extruieren wir das vordere obere Polygon eines 
Fingers zwei mal. Dann wechseln wir in den Punktmodus und collapsen 
die vorderen Punkte der oberen beiden Extrusionsebenen, so dass das 
Ergebnis wie links abgebildet aussieht. Danach skalieren wir die hier 
abgebildeten gelben Punkte etwas zusammen und verschieben sie unter die 
Fingerkuppe. Als nächstes markieren wir die hier rot abgebildeten Punkte, 
skalieren sie noch mehr zusammen wie die gelben davor und verschieben 
sie bis vor zur Fingerkuppe(siehe Bild). Letztendlich markieren wir die 
hier hellblauen Vertices, skalieren sie genausoweit zusammen und 
verschieben sie an die Stelle des Nagelbettes.
Wir erstellen uns nun wieder ein Referenzobjekt mit MeshSmooth und 
verbessern die Form der Fingerkuppe und des Nagels noch ein wenig. 
Wenn wir mit dem Ergebnis zufrieden sind markieren wir die Polygone der 
Fingerkuppe und detachen sie wiederum als Klonobjekt. Das Klonobjekt 
kopieren wir dann noch drei mal. Als nächstes müssen wir die 
Fingerkuppenpolygone der anderen Finger löschen. Dann nehmen wir ein 
Klonobjekt, schieben es bis an den Finger heran und skalieren es auf die 
passende Größe für den Finger. Im Punktmodus können wir dann die 
Fingerkuppe über das collapsen der Eckpunkte mit dem Finger verbinden. 
Dieser Vorgang ist ebenfalls nochmals kurz links bebildert. Dasselbe 
Verfahren wenden wir dann auch bei den restlichen Fingern sowie beim 
Daumen an.

Der Daumen
Als erstes verschieben wir wieder einige Punkte, so dass das Abknicken 
des Daumens wie im Bild links erkennbar wird. Dann wählen wir die 
Punkte des oberen Daumengelenkes und der Daumenkuppe aus und 
rotieren sie um ca 45° um die lokale Achse nach außen. Das Ergebnis 
müsste dann in etwa wie das links gezeigte Bild aussehen.

Nun geht es an das Finetuning der Hand. Und zwar sollten wir hier vor 
allem die Handinnenfläche etwas eindrücken, den Hautlappen zwischen 
Daumen und Zeigefinger etwas dünner machen, die Fleischwulst am 
Übergang Hand zu Daumen etwas herausarbeiten und den Handrücken 
etwas ausformen. Wie gesagt ist die eigene Hand das beste Vorbild ;o) 
Ausserdem müssen wir darauf achten zum Handgelenk hin einige Vertices 
zu collapsen, da wir am Ende nur fünf Vertices haben wollen um die Hand 
richtig mit dem Arm verbinden zu können. Um das zu erreichen können 
wir auch noch eine Zwischenextrusion machen. Haben wir die 
Verticeanzahl erreicht und sind mit der Hand zufrieden können wir den 
Übergang schaffen. Dazu löschen wir die Polygone an den 
Verbindungsstellen und attachen die Hand zum Körpermesh. Im 
Punktmodus schieben wir die Hand an den Arm heran und skalieren die 
Hand eventuell nochmal auf die richtige Größe. Dann suchen wir für jeden 



der Verschmelzungsunkte der Hand einen Partner am Arm und collapsen 
diese. Und schon sind Arm und Hand fertig :o)

Jetzt müssen wir nur noch alle Polygone von Arm und Hand selektieren, 
als Klon detachen und auf die andere Seite spiegeln. Vor dem 
Zusammenfügen, dh collapsen der Punkte müssen wir jedoch daran denken 
die Polygone an der Verschmelzungsstelle zu entfernen. Das Ergebnis sieht 
dann einerseits als LowPoly und andererseits als MeshSmooth-Referenz 
etwa wie unten abgebildet aus. Das geht doch schon ganz gut in Richtung 
eines menschlichen Characters...oder? ;o)

 



 

Chapter11 - Kleidung

 : Materialeditor (Hotkey M)

 : im Materialeditor; macht das aktuelle Material doppelseitig

 : im Materialeditor; weist das Material dem ausgewählten 
(Sub)Objekten zu

Jetzt sollten wir unserem Freund noch etwas Anzuziehen geben. Ich habe 
mich für einen lockeren kurzärmigen hüftlangen Mantel und ein 
langärmiges bis unterhalb des Ellbogen reichendes Hemd entschieden.

Der Mantel
Wir suchen uns zunächst wie bei der Hose die Polygone raus, die wir für 
den Mantel benötigen. Es reicht aus wieder nur eine Hälfte zu modelieren 
und dann zu spiegeln und zusammenzusetzen. Aus den Polygonen erstellen 
wir ein neues Objekt namens Mantel. Danach verschieben wir einige 
Punkte so, dass der Mantel sich nicht mehr mit den Körperpolygonen 
überschneidet. Als nächstes wählen wir die unteren Edges des Mantels und 
extruieren sie nach unten, so dass der Mantel seine Hüftlänge begommt. 
Die Extrusion des Kragens erfordert wieder etwas mehr Geduld und 
Fingerspitzengefühl funktioniert aber genauso.
Damit wir den Kragen nun von beiden Seiten sehen können weisen wir 
ihm zunächst ein doppelseitiges Material zu. Wir drücken die Taste M und 
befinden uns im Materialeditor. Dort klicken wir auf eine Kugel bzw den 
sogenannten Materialslot. Es öffnet sich ein Rollout, in dem wir eine 
Checkbox mit der Bezeichnung 2Sided finden, die wir aktivieren. Dann 
ziehen wir die Kugel per drag&drop auf das Mantelobjekt oder klicken den 
Zuweisebutton nachdem wir das Objekt selektiert haben. Dann können wir 
den Materialeditor vorläufig wieder schließen. Den Mantel gestalten wir 
anhand eines Referenzobjektes noch etwas lockerer. Eventuell können wir 
sogar einige Punkte zusammenfassen um ein einfacher bearbeitbares Mesh 
zu bekommen. Wenn wir zufrieden sind spiegeln wir eine Kopie und 
'nähen' den Mantel über collapsen der entsprechenden Punkte hinten 
zusammen.
Die verdeckten Polygone des Körpermeshes am Arm und am Rücken 
können wir dann schon entfernen bevor wir uns das Hemd vornehmen.



Das Hemd
Auch bei dem Hemd markieren wir zunächst auf dem Körper-Mesh die 
wichtigen Polygone. Das sind hier die Polygone an Bauch, Brust, im 
Halsbereich und an den Oberarmen. Daraus erstellen wir ebenfalls wieder 
ein neues Objekt. Das Mesh können wir dann durch collapsen einiger 
'unwichtigerer' Punkte vereinfachen. Die Punkte ordnen wir dann so an, 
dass sie einerseits unter dem Mantel bleiben jedoch auch nicht im 
Körpermesh verschwinden. Dann formen wir den Kragen wieder durch 
Extrusion der oberen Edges. Hier sollten wir uns etwas mehr Zeit lassen, 
da das eine sehr diffizile Arbeit ist zwischen Körper- und Mantelmesh zu 
arbeiten. Dem Hemd weisen wir dann ebenfalls wie dem Mantel ein 
doppelseitiges Material zu.
Dann bearbeiten wir die Ärmel, wobei wir die oberen Punkte unter den 
Mantel schieben und am Ellbogen noch einmal nach innen in das Armmesh 
extruieren. Anhand eines Referenzobjektes, das wir mit den anderen 
Referenzobjekten zu einer Figur zusammensetzen können wir noch einmal 
Korrekturen vornehmen und die Punkte richtig anordnen. Am Körpermesh 
löschen wir dann wieder die am Bauch nicht mehr sichtbaren Polygone.

Das zusammengesetzte Referenzobjekt könnte dann ähnlich wie links 
abgebildet aussehen.

 



 

Chapter12 - Armband & Kette
Ausserdem wollen wir ihm nun noch zwei Lederarmbänder und eine Kette 
verpassen.

Das Armband
Damit das Armband richtig am Arm sitzt erstellen wir sie per boolscher 
Operation. Dafür ordnen wir zunächst einige Boxen zB so wie links 
abgebildet direkt am HighPoly bzw ReferenzObjekt an. Wir fassen die 
Boxen zu einem EditableMesh zusammen, indem wir eine Box 
konvertieren und die anderen attachen. Wir müssen nur darauf achten, dass 
die Box den Arm vollständig an den Stellen, wo später das Armband sein 
soll, überlagert. Als nächstes selektieren wir das Mesh und gehen unter 
Create -> Geometry -> CompoundObjects auf Boolean. Dort wählen wir 
Intersection und den Typ Copy. Wir drücken den OperandB-Button und 
wählen den Arm aus. Dann schauen wir uns das Armband an und ergänzen 
eventuell noch einige fehlende Polygone indem wir es in ein EditableMesh 
konvertieren, in den Polygonmodus wechseln und über den Create-Button 
Polygone aufspannen.
Das Armband sieht dann in etwa wie links auf dem Bild aus. Nun 
extruieren wir alle Polygone noch etwas nach außen wobei wir unter 
Normale Local aktivieren. Für die andere Seite spiegeln wir dieses 
Armband und schieben es zurecht.

Die Kette

 : im Create-Register; Auswahl der Shape-Grundobjekte

Die Halskette erstellen wir einfacherweise per LoftObjekt. Zunächst 
zeichnen wir in der Frontansicht einen Dreiviertelkreis mittels eines 
3PunkteSplines mit zwei BezierCorner-Punkten an den Enden und einem 
Smooth-Punkt dazwischen als PfadSpline für das LoftObjekt. Einen Spline 
zeichnen wir über Create -> Shapes -> Line über setzen von Punkten. Den 
Spline beenden wir mit der rechten Maustaste. Die Punkttypen können wir 
ändern, indem wir im Punktmodus den Punkt auswählen, die rechte 
Maustatse drücken und im Popupmenü dann den gewünschten Typ 
auswählen. Nun erstellen wir in der Seitansicht drei Splinekreise 
unterschiedlicher Größen als Querschnitte. Wir wählen den Spline aus und 
gehen unter Create -> Geometry -> CompoundObjects auf Loft. Im Rollout 
drücken wir den GetShape-Button und wählen als ersten Querschnitt den 
kleinsten Kreis. Dann drehen wir den Path-Parameter auf 35% und wählen 
nochmals den Kreis aus. Bei 40% wählen wir den größten, bei 45% wieder 
den kleinen, bei 50% den mittelgroßen und dann genauso umgekehrt weiter 
die Kreise entsprechend aus. Da wir das LoftObjekt als Instance erstellen 
ist es abhängig von den Splines. Das bedeutet, wenn wir nun die Splines 
verändern hat dies direkte Auswirkungen auf das LoftObjekt. Wir machen 
uns dies zunutze und können dadurch durch Verschieben der BezierPunkte 
am PfadSpline unserer Figur die Kette umhängen. Dabei achten wir darauf, 
dass die Enden vollständig unter dem Kragen des Hemdes verschwinden 
und es keine Überschneidungen gibt.



Zwischenrendering

 : Renderbutton, Rendereinstellungen können 
im Menü Rendering -> Render eingestellt werden

Der Modelingteil ist nun so gut wie 
abgeschlossen, wobei wir die Augen und die 
Haare im Texturierteil behandeln werden. Aus 
diesem Anlass haben wir uns ein kleines 
Zwischenrendering unseres HighPoly-Objektes 
(hier mit Farbzuweisungen auf die einzelnen 
Objekte) wohlverdient ;o)
Das sieht dann in etwa so aus.

 



 

Chapter13 - Auge & Textur

 : im Materialeditor; zeigt die Bitmaptextur in den Smooth-Viewports

 : im Materialeditor; wechselt eine Ebene höher zum Parent

 : unter Modify; weist dem Objekt entsprechende 
Mappingkoordinaten zu

Wir arbeiten nun fast ausschließlich nur noch am HighPoly bzw den 
Referenzobjekten. Zunächst setzen wir in die Augenhöhle ein Auge ein. 
Wir erstellen dafür wieder eine Kugel, deren Polpunkte bei Frontalsicht 
rechts und links sein sollten. Die Größe wiederum etwa von der Schläfe bis 
zum Nasenrücken. Dann sollte sie in etwa mittig, leicht zur Nase orientiert 
an der Augenhöhle ausgerichtet werden. Eventuell müssen wir die Punkte 
um das Auge herum noch einmal mittels Punktverschiebung und 
SoftSelection anpassen, wobei wir wieder parallel beidseitig arbeiten 
sollten. Dann erstellen wir in unserem 2D-Programm eine Augentextur. 
Ein 400x400er Bitmap reicht vollkommen aus. Wichtig ist es die 
Glanzpunkte schon in der Textur zu setzen, eine nicht zu einfarbig 
gestaltete Pupille zu erstellen und einige leicht angedeutete Blutbahnen im 
Augenweiß zu zeichnen. Am besten anhand einer Vorlage zB mit Spiegel 
arbeiten. Auch sollte die Pupille nur einen sehr kleinen Platz auf dem Bild 
einnehmen. In 3DStudio weisen wir nun unserer Kugel ein UVWMap zu, 
indem wir unter Modify -> UVWMap Spherical wählen. Wir sehen nun 
das Map-Gizmo. Sicherheitshalber die Buttons Fit und Center im Rollout 
drücken um das Gizmo anzupassen. Nun stellen wir im 
Materialeditor(Hotkey M) das Augenmaterial her. Dazu wählen wir einen 
freien Materialslot aus und schauen uns einmal die Rollouts an. Dann 
wählen wir für die Ambientfarbe(Schattenfarbe) ein dunkles Grau, für die 
Diffusefarbe(Objektfarbe) ein dunkles Rot und für die 
Specularfarbe(Spitzlichtfarbe) ein Weiß. Bei SelfIlumination deaktivieren 
wir den Haken und drehen den Wert auf etwa 65. Das macht das Objekt 
etwas unabhängiger von der Beleuchtung. Ausserdem stellen wir den Wert 
für Spitzlichter auf 0. Im Maps-Rollout drücken wir den Button für das 
DiffuseMap, wählen Bitmap und dann unsere Augentextur aus. Dann 
weisen wir das Material per drag&drop oder Button der Kugel zu. Wir 
gehen zurück zur Parentebene und stellen den Wert für das DiffuseMap auf 
75, damit die rote Diffusefarbe etwas durchscheint. Dann wechseln wir 
wieder in die DiffuseMap-Ebene und machen das Bitmap für die 
Ansichtsfenster sichtbar(siehe Erklärung oben). Im UVWMap-Rollout 
wechseln wir in den SubObject-Modus und rotieren nun das Gizmo, bis 
wir die Pupille frontal ausgerichtet haben. Nun müssen wir noch die Größe 
im Materialeditor über UV-Tiling beim DiffuseMap anpassen. Die haken 
bei Tile und Mirror kommen weg, so dass das Bitmap nur einmal 
gezeichnet wird und ansonsten die Diffusefarbe durchscheint. Bei mir hatte 
das Auge bei U=2,6 und V=1,3 die richtige Größe(der eine Wert ist immer 
aufgrund des Mappings immer doppelt so groß). Dann kopieren(nicht 
spiegeln ;o) wir das Auge und setzen es in die andere Augenhöhle. Wenn 
man nun am UVW-Gizmo nichts mehr korrigieren muss sind beide Augen 
ideal angepasst. Jedoch ist dies selten der Fall und um einen 'schiefen 



Blick' zu vermeiden muss man meistens etwas nachkorrigieren.

 



 

Chapter14 - Die Haare

 : im Materialeditor; Karohintergrund für transparente Materialien im 
Materialslot

Bei den Haaren machen wir uns die in 3DStudio geniale Renderbarkeit der 
Splines zunutze. Dadurch erreichen wir sehr einfach und übersichtlich 
einen schönen Haarschopf und können alle möglichen Frisuren modelieren. 
Wir erstellen zunächst ein Spline mit drei Punkten(ein BezierCorner und 
zwei Smooth). Die Box für MappingCoordinates müssen wir aktivieren 
und für die InterpolationsSteps nehmen wir vorerst mal 3. Wenn die Haare 
nachher zu eckig sind können wir bei einzelnen Splines diesen Wert auch 
höher setzen. Ausserdem schalten wir Renderable an und drehen die Dicke 
stark nach oben...bei mir war der Wert 14 ausreichend. Dann erstellen wir 
in unserem 2D-Programm eine Haartextur, die in etwa wie die links oben 
abgebildete aussieht. Eine Bildgröße von 200x300 sollte ausreichen. 
Wichtig ist es, dass der Kontrast schwarz-weiß recht hoch ist und die 
dunklen Stellen am Rand den RGB(0,0,0) haben. Dies wird unser 
OpacityMap, wobei schwarz 100%ig transparent und weiß 0% transparent 
ist. In 3DStudio öffnen wir den Materialeditor und wählen einen freien 
Slot. Für die Ambientfarbe wählen wir schwarz, für die Diffusefarbe 
dunkelbraun und für die Specularfarbe weißgelb. Den Wert für Spitzlicht 
drehen wir wieder auf 0. Ausserdem aktivieren wir 2Sided. Im Maps-
Rollout wählen wir den OpacityKanal, dann Bitmap und unsere Haartextur. 
Durch das Anwählen des Karohintergrundes können wir an der Kugel im 
Materialslot die Transparenz gut erkennen. Zurück im Maps-Rollout 
ziehen wir das OpacityMap per drag&drop als Instanz auf den BumpKanal. 
Instanz bedeutet, dass alle Änderungen, die wir nun innerhalb eines der 
beiden Kanäle vornehmen genauso an dem anderen vorgenommen werden. 
Die Bumpstärke können wir ruhig etwas höher schrauben. Als nächstes 
weisen wir dem Spline dieses Material zu und machen ein Testrendering, 
um zu überprüfen in welche Richtung das Material gemappt ist. Wenn es 
richtigherum liegt, dh die Fransen nach unten hängen, ist alles in Ordnung. 
Ansonsten müssen wir das Bitmap umdrehen indem wir im OpacityKanal 
die U-Mappingkoordinate um 180° rotieren. Dies geschieht über die 
Eingabezeile U neben dem UV-Tiling. Um noch etwas Abwechslung zu 
schaffen legen wir auf den DiffuseKanal zB ein SmokeMap und reduzieren 
die Wirkung der Map auf etwa 20. Jetzt kopieren wir den Spline einige 
Male und verschieben die Punkte so, dass das Haar eine gute Form 
bekommt. Es reicht aus zunächst nur eine Hälfte des Kopfes mit etwa 10 
Splines zu bedecken. Daran denken, dass das Material unten transparent ist 
und wir somit die Splines etwas länger machen sollten. Ausserdem sollten 
die Splines relativ nahe auf der Kopfhaut entlanglaufen. Dies kann man gut 
in der geshadeten Perspektivansicht erreichen, indem man die Punkte 
solange Richtung Kopf verschiebt, bis sie gerade noch zu sehen sind. Ein 
Testrendering ohne Material sieht in etwa wie links oben aus. Da die Haare 
nun noch nicht dicht genug sind setzen wir zwischen alle zwei Splines eine 
Kopie des Vorgängers, die wir leicht verändern. Interessant sieht es aus, 
wenn sich die Splines teilweise überschneiden. Die Renderzeit wird durch 
die Transparenzen ordentlich in die Höhe geschraubt, weshalb wir für 
Testrenderings in den RenderOptionen[Rendering -> Render] den 



AntiAlias abschalten und eine geringere Auflösung wählen sollten. Dann 
können wir ein Testrendering mit zugewiesenem Material machen. Sind 
wir zufrieden wählen wir alle Splines aus und spiegeln sie als Kopie auf 
die andere Seite. Damit die Frisur nicht zu symmetrisch aussieht 
verschieben wir einige Punkte auf dieser Seite. Wenn nach dem 
Testrendering die Haarpracht zu hoch sitzt, was aufgrund der Splinedicke 
gut möglich ist, wählen wir alle Splines aus und skalieren sie etwas runter.

 



 

Chapter15 - Die Wimpern

 : im Materialeditor; lädt das Material des angewählten Objekts in 
den Slot

 : im Mesh-Rollout; wählt die SubObjekte 
anhand ihrer MaterialID aus

Die Augenwimpern sollen natürlich auch nicht fehlen. Zunächst weisen 
wir dem Kopfmesh ein Material aus dem Materialeditor zu, dass wir Haut 
nennen. Dann extruieren wir aus den oberen inneren Edges des Auges eine 
Polyonreihe. Wir lassen die Polygone ausgewählt und weisen ihnen ein 
neues Material zu. Wenn wir aus dem SubObjekt-Modus rausgehen und 
mit der Pipette im Materialeditor das Kopfmesh anklicken erscheint im 
Materialslot ein Multi/Subobjekt-Material. Dieses wird in diesem Fall vom 
Programm automatisch erstellt und den entsprechenden SubObjekten 
Material-ID's zugewiesen. ID1 ist nun die Haut und ID2 sind die oberen 
Wimpern. Als nächstes erstellen wir wie bei den Haaren für die Wimpern 
ein OpacityMap, dass ähnlich wie das oben links aussehen kann. Dann 
bearbeiten wir im Multi/SubObjekt-Material das Wimpernmaterial unter 
ID2. Dort wählen wir als OpacityMap unser Bild und nehmen wie bei den 
Haaren die Farb- und Spitzlichteinstellungen vor. Ausserdem wählen wir 
wieder 2Sided. Jetzt müssen wir nur noch das Bild richtig auf die Polygone 
legen. Dies erledigen wir mit Hilfe des Modifiers UnwrapUVW. Wir 
weisen dem ganzen Mesh einfach einen UnwrapUVW-Modifier[Modify -> 
More] zu. Im Rollout drücken wir nun den Edit-Button und es öffnet sich 
ein Fenster. Oben rechts wählen wir die Wimperntextur aus und unten die 
ID2. Im Fenster müssen wir nun noch das Netz richtig auf dem Bild 
positionieren, indem wir die Punkte dementsprechend verschieben. Wenn 
wir im Materialeditor die Textur in den Ansichten sichtbar gemacht haben 
können wir während dem Arbeiten am Unwrap sofort die Auswirkungen 
sehen. Im Endeffekt sollte es dann wie links abgebildet aussehen. Sind wir 
zufrieden wenden wir zunächst den EditMesh-Modifier[Modify -> More] 
an, um die Unwrap-Infos mitkopieren zu können und später keine Infos zu 
verlieren. Dann wählen wir die Wimpern-Polygone aus, was über den im 
Mesh-Rollout befindlichen SelectByID-Button schnell geschehen ist, 
detachen sie als Kopie, spiegeln das neue Objekt, attachen das Kopfmesh 
mit dem Objekt und collapsen die Punkte miteinander. Genauso verfahren 
wir dann mit den unteren Wimpern.
Es ist sehr wichtig vor dem kopieren den EditableMesh-Modifier 
anzuwenden. Dann mit diesem weiterarbeiten und den UnwrapUVW-
Modifier immer nur auf das ganze Objekt anzuwenden. Nach dem Unwrap 
dann sofort wieder einen EditableMesh zuweisen. Dann kann man bis zum 
vorigen EditableMesh den Stack bedenkenlos collapsen. Das bedeutet im 
Stack sollte immer die Reihenfolge EditableMesh -> UnwrapUVW(auf das 
gesamte Mesh angewandt) -> EditableMesh vorhanden sein. Ist das der 
Fall kann man nämlich auch später im Unwrap problemlos alle Punkte 
noch bearbeiten und verliert keine Informationen, was sehr nervig sein 
kann ;o)



 



 

Chapter16 - Die Kopftextur

 : unter Bitmapauswahl im Materialeditor; lädt das 
ausgewählte Bitmap neu

Den Kopf wollen wir natürlich auch über eine Bitmaptextur texturieren. 
Dafür wählen wir zunächst, nachdem wir die Arm- und Beinpolygone 
versteckt haben, über SelectID alle Kopfpolygone bis auf die Wimpern 
aus. Diesen weisen wir wiederum ein neues Material zu, wodurch im 
Multi/Subobjekt-Material eine neue ID und ein neues Untermaterial erstellt 
wird, das wir Head nennen. Als nächstes weisen wir den Polygonen ein 
UVWMap zu. Bei Gesichtern ist das zylindrische Mapping den anderen 
meistens vorzuziehen. Im Rollout das richtige Alignment wählen, so dass 
der Zylinder senkrecht steht und dann Fit und Center drücken um das 
Gizmo anzupassen. Wenn wir in den Subobjektmodus gehen erkennen wir, 
dass das Gizmo auf einer Seite eine Grüne Kante hat. Diese zeigt uns an, 
wo das Mesh auseinandergeschnitten und wierum es dann abgewickelt 
wird. Bei uns sollte diese Linie am Hinterkopf entlanglaufen. nun erstellen 
wir in einem 2D-Programm ein schwarzes Bitmap, wobei die Maße 
500x500pxl ausreichen. nur wer eine sehr detaillierte Gesichtstextur 
erstellen möchte sollte dementsprechend eine höhere Auflösung 
verwenden. In 3DStudio laden wir dieses schwarze Bitmap in den Diffuse-
Kanal unseres Headmaterials. Wir gehen aus dem Subobjektmodus heraus 
und weisen dem Mesh erneut einen UnwrapUVW-Modifier zu. Wir 
drücken Edit und wählen oben rechts das schwarze Bitmap und unten die 
richtige MaterialID aus. Wenn das Netz größer ist wie der schwarze 
Bereich wählen wir alle punkte aus und skalieren das ganze Netz in den 
Bereich hinein. Die Punkte, die dann noch aus dem schwarzen Bereich 
herausragen schieben wir in ihn hinein. Dann vergrößern wir den Bereich 
mit der Lupe so weit möglich und vergrößern das Fenster möglichst 
gleichmäßig, bis es die volle Bildschirmhöhe einnimmt. Ein Druck auf die 
Print-Taste macht einen Screenshot. Diesen laden wir in unser 3D-
Programm und schneiden den schwarzen Bereich mit dem Netz aus. 
Diesen Bereich können wir nun anhand des Netzmusters gut bearbeiten, da 
wir ja Augen, Nase, Mund etc gut erkennen können. Wichtig ist es das Bild 
vor dem Speichern wieder auf die 500x500er Größe zu runterzuskalieren. 
Das Diffusebitmap ist die Haupttextur, die die Farben angibt, das 
Specularbitmap besteht aus Graustufen, wobei die helleren Werte 
Spitzlichter eher zulassen wie dunkle Werte und das Bumpmap ist 
ebenfalls ein Graustufenbitmap, dass uns Erhebungen und Vertiefungen 
wie zB Falten und Poren darstellen lässt, wobei helle Werte Erhöhungen 
und dunkle Werte Vertiefungen sind. Links habe ich die Bitmaps 
abgebildet, die ich verwendet habe. Per Klick kannst Du Dir die jeweilige 
Textur in Originalgröße anshen. Mit Hilfe eines BrushTools, einem guten 
Blur und mehreren Ebenen lassen solche Texturen relativ gut erstellen. Um 
dann erkennen zu können, ob eine Textur richtig sitzt und nicht zB der 
Mund zu breit ist lassen wir uns das Bitmap wiederum in der geshadeten 
Perspektivansicht anzeigen. Wir laden dann das neue Bild an Stelle des 
schwarzen Bildes und checken die Lage. Gut ist es hier aufgrund der 
schnellen Korrekturmöglichkeit parallel mit seinem 2D-Programm und 
3DStudio zu arbeiten. Stimmt was nicht wechselt man schnell ins 2D-



Programm, ändert eine Kleinigkeit, speichert und 'reloaded' das Bild. Eine 
gute Texturierung nimmt einiges an Zeit in Anspruch jedoch werden wir 
nachher auch mit einem recht hübschen Zwischenrendering belohnt.
Sind wir zufrieden, dann weisen wir dem mesh wiederum einen 
EditableMesh-Modifier zu, collapsen den Stack, so dass wir nur noch 
EditableMesh -> UnwrapUVW -> EditableMesh darin stehen haben und 
lassen uns auch wieder die bisher versteckten Polygone anzeigen.

Zwischenrendering

Ein Zwischenrendering des komplett texturierten 
Kopfes mit Haaren und AntiAlias gerendert sieht 
in etwa so aus. Die Kanten an den Haaren können 
wir noch über das hochdrehen der Steps im 
SplineRollout abrunden.
Ich finde das sieht aber schon so ganz ordentlich 
aus :o)

 



 

Chapter17 - Ketten- & Armbandtextur
Die Kette belegen wir frontal mit einem planaren UVW-Map, das wir über 
Center und Fit anpassen. In der FrontView machen wir einen 
Screenshot(Print-Taste drücken lädt den Screenshot in die 
Zwischenablage) und bearbeiten diesen in einem 2D-Programm, wobei wir 
das Gitter so knapp wie möglich quadratisch ausschneiden. Über 
verschiedene Layer im 2D-Programm kann man das Gitter als Vorlage 
verwenden, indem man es etwas transparent macht und auf eine 
darunterliegende Ebene seine Textur zeichnet. Wie so oft sind auch hier 
das Brushtool, der Weichzeichner und die Ebenen die besten Verbündeten 
;o) Die Textur kann dann zB wie links abgebildet aussehen. Das Bild laden 
wir als DiffuseMap. Ich habe weiterhin im Materialeditor folgende 
Einstellungen vorgenommen: SpecularLevel 18, Glossiness 11, 
SelfIlumination 15, AmbientColor schwarz, DiffuseColor braun, 
SpecularColor weiß.

Die Armbänder können wir einfach nur über die DiffuseColor färben. Ein 
dunkles Braun als Diffuse-, weiß für die Specular- und schwarz für die 
AmbientColor. Ein Noise oder Cellularmap für den Bumpkanal bringt 
noch etwas mehr Struktur. 

 



 

Chapter18 - Hemd-, Mantel- & Hosentextur
Das Hemd können wir ebenfalls über ide DiffuseColor einfärben. Für den 
Bumpkanal verwenden wir wieder ein NoiseMap um das Hemd faltiger 
erscheinen zu lassen.

Genauso können wir auch bei dem Mantel verfahren. Jedoch nehmen wir 
statt dem Noise ein CellularMap.

Die Hose texturieren wir ebenfalls wie den Kopf über ein zylindrisches 
UVW-Mapping, UnwrapUVW und das Screenshot-Verfahren. Der 
Vorgang ist derselbe, weshalb ich mir eine genauere Ausführung erspare 
:o) Das DiffuseMap und die Hose mit Textur sehen ungefähr wie links 
dargestellt aus.

Chapter19 - Haut & Schuhtextur
Die Arme und Beine texturieren wir aufgrund der Farbgleichheit zum Kopf 
ebenfalls mittels eines Bitmaps. Zunächst wechseln wir im Materialeditor 
zu unserem Multi/SubobjektMaterial, die wir notfalls über die Pipette 
reinladen können. Dort erhöhen wir über den SetNumber-Button die 
Anzahl der SubObjektTexturen auf 5 und benennen diese als Beintextur. 
Dann erstellen wir anhand der Kopftextur eine Hauttextur für die Beine, 
die etwa die gleichen Farbtöne besitzt. Eine Bitmapgröße von 320x240 
reicht aus. Dieses Bitmap laden wir dann als DiffuseMap. Als nächstes 
wählen wir die Polygone eines Beines aus, weisen ihnen ein zylindrisches 
UVWMap zu und legen das Material darauf. Wenn man genauer 
texturieren möchte kann man natürlich auch hier wiederum das Unwrap-
Screenshot-Verfahren anwenden ;o) Bei dem anderen Bein verfahren wir 
genauso.

Die Arme und Hände texturieren wir ebenfalls nur grob über diese 
Hauttextur und einem zylindrischen UVWMap. Auch hier ist noch 
Spielraum für genauere Texturierungen mittels UnwrapUVW, wobei dies 
bei der Hand noch ein relativ schwieriges Kapitel ist ;o)
Eventuell können wir bei Armen und Beinen noch ein CellularBump 
verwenden.

Die Schuhe können wir auch einfacherweise per planarer UVWMap 
texturieren, so dass wir in der Seitansicht einen Screenshot vom Wireframe 
machen können, dieses im 2D-Programm bearbeiten und dann als 
DiffuseMap auf die Schuhe mappen. Wir können uns wiederum Arbeit 
ersparen, indem wir einen Schuh fertigmappen und diesen dann kopieren 
und spiegeln, wobei wir den anderen Schuh ersetzen. Das Verfahren läuft 
genauso wie beim Texturieren der Kette. Nachdem wir nun das Bitmap 
richtig auf den Schuh gesetzt haben können wir nochmals auf ihn einen 
EditMesh-Modifier anwenden und einige Kleinigkeiten mittels 
Puntverschiebung und Softselection verbessern, wobei sich die Textur 
mitverschiebt :o) Textur und die gemappten Schuhe sind links abgebildet. 

 



 

Chapter20 - Licht, Schatten & Rendering

 : im CreateRegister; Kamera erstellen

 : im CreateRegister; stellt Lichter zur Verfügung

Nun schauen wir nocheinmal, ob die Figur aus den Referenzobjekten 
richtig zusammengesetzt ist. Dan wählen wir alle LowPolys aus und 
gruppieren diese[Menü: Group -> Group]. Nachdem wir die Gruppe 
benannt haben verstecken wir sie. Als nächstes bauen wir einen Boden 
mittels PatchGrid oder einfacher Box. Diese texturieren wir zB hellgrau.

Im nächsten Schritt erstellen wir eine FreeCamera, die wir durch 
Rotationen in Richtung unserer Figur ausrichten. Wichtig sind für uns im 
Rollout die EnvironmentRange-Einstellungen. Dort aktivieren wir Show 
und drehen den NearRange-Regler soweit nach oben, bis sie knapp hinter 
der Figur ist. Die FarRange stellen wir etwa auf dreifache Weite. Diese 
Werte benötigen wir um den Bereich für den Nebeleffekt einzustellen, den 
wir nachher noch unserer Szene hinzufügen. Wir gehen auf ein 
Viewfenster und drücken den Hotkey C für Camera. Anhand der 
Werkzeuge unten rechts können wir wie im Perspectivefenster die 
Kameraansicht anpassen. Sind wir zufrieden können wir mit der 
Beleuchtung der Szene beginnen.

Die Szene leuchten wir durch drei OmniLights aus. Einem Hauptlicht von 
oben rechts, einem Backlight, dass die Szene im Hintergrund etwas 
ausleuchtet und einem Seitenlicht, dass der Szene noch ein etwas 
interessantere Beleuchtung geben soll. Die Omnis setzen wir einfach über 
das Create -> Light-Rollout. Das Hauptlicht färben wir weißgelb, den 
Multiplier, das bedeutet die Leuchtintensität, stellen wir auf 0,8. 
Ausserdem müssen wir, da diese Lichtquelle Schatten erzeugen soll, die 
Checkbox CastShadow aktivieren. Da nur ein RaytraceShadow bei 
transparenten Texturen wie zB den Haaren Schatten berechnet wechseln 
wir im ShadowParameters-Rollout die ShadowMap in RaytraceShadow 
um. Da die Berechnung einiges länger dauert ist dies das einzige Licht, bei 
dem wir den RaytraceShadow verwenden. Das Backlight färben wir 
hellgrau und stellen den Multiplier zB auf 0,2. Das Seitenlicht können wir 
etwas farbiger gestalten zb mit einem weißblau. Den Multiplier können wir 
auch auf etwa 0,3 stellen. Wir müssen bei der Beleuchtung auf eine 
ausgewogene aber trotzdem interessante Stimmung achten. Die Multiplier 
der Lichter sollten insgesamt nicht höher sein als 1,5 um eine zu starke 
Überbeleuchtung zu vermeiden. Natürlich kann man im Rollout auch den 
Leuchtbereich, den Falloff einstellen. Diese Werte sollten für uns jedoch 
mal reichen :o)

Nun wollen wir noch etwas Nebel für den Hintergrund. Im Menü 
Rendering -> Environment können wir einige Umgebungseinstellungen 
vornehmen. Unter anderem die BackgroundColor, die wir auf ein graublau 
stellen sowie die allgemeine Umgebungsfarbe 'GlobalTinting' die wir auf 
ein ganz helles gelb einfärben. Weiter unten finden wir ein Atmosphere-
Rollout, in dem wir den Add...-Button drücken, wodurch sich ein Fenster 
öffnet, in dem wir Fog bzw Nebel auswählen. Die Nebelfarbe lassen wir 



weiß, FogBackground aktivieren wir, damit der Nebel gegen den 
Hintergrund verrechnet wird. Ausserdem aktivieren wir die exponentielle 
Zunahme des Nebels von der Near-Dichte 0% bis zur Far-Dichte 100%. 
Diese Dichtenwerte werden nun an die im KameraRollout eingestellten 
Near- und Farwerte gesetzt, so dass der ganze Bereich vor der Figur 
nebelfrei ist.

Vor dem großen Rendering stellen wir noch im Menü Rendering -> Render 
den AntiAlias wieder ein und wählen die richtige Ausgabegröße aus. Dann 
unten das Kamerafenster wählen und das Rendern über den Renderbutton 
starten.

Ich hoffe du bist mit dem Ergebnis zufrieden ;o)

Viel Spass weiterhin...
Michael 'Mechiil' Brempel
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